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1. Цель работы 
Введение в высокочастотное аппаратное оборудование компании NI. 

Программирование устройства приема сигнала, устройства генерирования 

синусоидального и АМ сигналов в LabVIEW. 

2. Установка и настройка оборудования USRP-2920 
NI USRP-2920 представляет собой платформу программно управляемого 

радио (SDR), которая может посылать и принимать сигналы для решения 

задач связи.   

Процесс запуска NI USRP-2920 состоит из шагов, перечисленных ниже. 

1. Подключите антенну или кабель к передней панели устройства NI 

USRP-2920.  

2. Подключите устройство напрямую к компьютеру с помощью 

экранированного Ethernetкабеля. 

3. Подключите к устройству сетевой блок питания 

4. Вставьте источник питания в сетевую розетку 

5. Замените IP-адрес вашего гигабитного Ethernet-порта на статический 

IP-адрес. National Instruments рекомендует статический IP-адрес 

192.168.10.1, т.к. устройство NI USRP-2920 по умолчанию имеет адрес 

192.168.10.2. 

6. Для того, чтобы открыть утилиту конфигурирования NI-USRP 

выберите Start»All Programs»National Instruments»NI-USRP»NIUSRP 

Configuration Utility. В окне утилиты выберите вкладку Change IP 

Address (Изменить IP-адрес). Ваше устройство должно появиться в 

списке с левой стороны вкладки, как показано на рисунке 2.1. 
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Рис. 2.1. – Подтверждение сетевого соединения. 

3. Краткое описание оборудования USRP-2920 

Рис. 3.1 - Передняя панель NI USRP-2920 

Таблица 3.1 – Разъемы передней панели модуля NI USRP-2920 

Разъем Использование 

RX1 

TX1 

Входной и выходной разъем ВЧ-сигнала. RX1 TX1 

является штыревым SMA разъемом с импедансом 50 Ом и 

представляет собой канал ввода или вывода, привязанный 

к общему проводу (single-ended). 

RX2 Входной разъем ВЧ-сигнала. RX2 является штыревым 

SMA разъемом с импедансом 50 Ом и представляет собой 

канал ввода, привязанный к общему проводу. 

REF IN Входной сигнал для внешнего опорного сигнала для 

местного гетеродина (LO). REF IN является штыревым 

SMA разъемом с импедансом 50 Ом и представляет собой 

канал ввода, привязанный к общему проводу. REF IN 

рассчитан на прием сигнала 10 МГц с минимальной 

входной мощностью 0 дБм (0,632 В) и максимальной 

входной мощностью 15дБм (3,56 В) для прямоугольного 

или синусоидального сигнала. 

PSS IN Входной разъем для опорного сигнала синхронизации PPS 

(имп./с). PSS IN является штыревым SMA разъемом с 
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импедансом 50 Ом и представляет собой канал ввода, 

привязанный к общему проводу. PSS рассчитан на прием 

сигналов ТТЛ от 0 В до 3,3 В и от 0 В до 5 В. 

MIMO 

EXPANSION 

Интерфейсный порт РАСШИРЕНИЯ (EXPANSION) для 

несколько входов, несколько выходов (MIMO) соединяет 

два устройства USRP с помощью совместимого MIMO-

кабеля. 

GB 

ETHERNET 

Порт гигабитного Ethernet предназначен для подключения 

разъема RJ-45 (Category 5, Category 5e, Category 6). 

POWER Разъем предназначен для подключения внешнего 

источника постоянного тока 3 А, 6В. 

Таблица 3.2 – Светодиодные индикаторы модуля USRP-2920 

Светодиод Индикация 

A Показывает состояние передачи модуля NI USRP-2920: 

ВЫКЛ – модель не передает данные 

ЗЕЛЕНЫЙ – модуль передает данные 

B Показывает состояние физического соединения MIMO-

кабеля: 

ВЫКЛ – модули не подключены с помощью MIMO-кабеля 

ЗЕЛЕНЫЙ – модули подключены с помощью MIMO-кабеля 

C Показывает состояние приема модуля NI USRP-2920: 

ВЫКЛ – модуль не принимает данные  

ЗЕЛЕНЫЙ – модуль принимает данные 

D Показывает состояние встроенного программного 

обеспечения модуля NI USRP: 

ВЫКЛ – программное обеспечение не загружено 

ЗЕЛЕНЫЙ – программного обеспечение загружено 

E Показывает состояние привязки к опорному синхросигналу 

гетеродина (LO) в модуле NI USRP-2920: 

ВЫКЛ – опорный синхросигнал не подан или гетеродин не 

привязан к синхросигналу 

МИГАНИЕ – гетеродин не привязан к опорному 

синхросигналу 

F Показывает состояние питания модуля NI USRP-2920: 

ВЫКЛ – питание модуля выключено 

ЗЕЛЕНЫЙ – питание модуля включено 
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Рис. 3.2 – Блок-схема USRP-2920 

3.1. NI USRP (Передача) 
Начнем с того, что обратим внимание на NI USRP, когда оно работает 

как передатчик. USRP принимает колебательный сигнал от хост-компьютера 

с разрешением 16 бит, который дискретизируется при частоте до 25 млн. 

сэмплов/сек. Этот сигнал преобразовывается с повышением частоты до 

высокой частоты (ВЧ), перед тем, как он посылается на усилитель и затем 

передается беспроводным способом. Для дополнительной информации по NI 

USRP, пожалуйста, смотрите файлы справки, связанные с USRP (Help⇒ NI 

USRP Help⇒Devices⇒ NI USRP-292x Specifications) (Справка⇒Справка по 

NI USRP ⇒Устройства⇒Спецификации NI USRP-292x) 

3.2. NI USRP (Прием) 
NI USRP также может принимать данные, и осуществляет это 

следующим образом. Принимаемый сигнал смешивается с желаемой 

несущей частотой для того, чтобы преобразовать его с понижением частоты 

до комплексного синфазно-квадратурного сигнала основной полосы частот, 

который дискретизируется при частоте 100 млн. сэмплов/сек. Затем 

понижается качество цифрового сигнала до частоты, определяемой 
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пользователем, и цифровой сигнал передается на хост-компьютер для 

обработки. 

Когда аналогово-цифровой преобразователь (АЦП) NI USRP проводит 

отсчеты при полной частоте АЦП (100 млн. сэмплов/сек), он может получить 

ширину полосы частот 20МГц. Дискретизация при такой большой частоте с 

высоким разрешением (14 бит) создает огромное количество данных. Однако 

чтобы получить сигнал с меньшей шириной полосы частот (узкополосный 

сигнал), достаточно проводить отсчеты при частоте, вдвое большей ширины 

частот сигнала. Частота дискретизации известна как минимально допустимая 

частота дискретизации системы. Это минимальная частота дискретизации, 

необходимая для воспроизведения сигнала с ограниченной полосой от 

дискретных отсчетов. 

Прореживание – это процесс уменьшения частоты дискретизации 

сигнала дискретного времени. На практике, это влечет за собой применение 

фильтра для подавления помех спектрального наложения и отклонения 

некоторых отсчетов. NI USRP предназначается для цифрового 

преобразователя с понижением частоты (ППЧ), который позволяет ему 

проводить прореживание в аппаратном оборудовании, вместо того, чтобы 

проводить его в программном оборудовании (что может быть значительно 

медленнее). 

Используя ППЧ, USRP может принимать узкополосные сигналы при 

частотах дискретизации намного меньше, чем полная частота АЦП (100 млн. 

сэмплов/сек), таким образом, сокращая объем памяти, необходимой для 

хранения колебательного сигнала. Например, колебательный сигнал, 

который дискретизируется при частоте 100 млн. сэмплов/сек, в течение 1 

секунды производит в 100 раз больше данных, чем тот же самый 

колебательный сигнал, дискретизирующийся при частоте 1 млн. сэмплов/сек. 

Эффективная частота дискретизации USRP (включая ППЧ) варьируется от 

максимальной частоты 25 млн. сэмплов/сек до 200 тыс. сэмплов/сек, и 

настраивается непосредственно пользователем. Для дополнительной 
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информации по NI USRP, пожалуйста, смотрите соответствующие файлы 

справки.  

4. Последовательность выполнения работы 

4.1.  Программирование устройства приема сигнала. 
Во данной части лабораторного исследования, вы создадите Устройство 

непрерывного СК (синфазно-квадратурного) сбора данных VI (Continuous IQ 

Acquisition VI). Блок-диаграмма этого устройства показана на Рисунке 4.2. 

Выполните следующие пункты: 

1. Выберите Start⇒Programs⇒National Instruments⇒LabVIEW 2013 ⇒ 

LabVIEW (Пуск⇒Программы⇒National Instruments⇒LabVIEW 2013 

⇒LabVIEW), чтобы запустить LabVIEW. Появляется диалоговое окно 

LabVIEW. 

2. Щелкните мышью на New (Новый), выберите Blank VI (Чистый ВИ), и 

щелкните на OK, чтобы создать чистый VI. 

3. Отобразите блок-диаграмму, нажав кнопкой мыши или выбрав 

Window⇒Show Block Diagram (Окно⇒Показать блок-диаграмму). 

4. Перейдите к VI NI USRP на палитре Functions⇒Instrument 

I/O⇒Instrument Drivers⇒NI-USRP⇒RX (Функции⇒Устройство 

ввода/вывода⇒Драйвера устройства⇒NI-USRP⇒Прием). Когда 

LabVIEW активна, нажмите тут, чтобы просмотреть палитру LabVIEW 

NI USRP TX (Прием NI USRP). 

Создайте блок-диаграмму, показанную на Рисунке 4.2, размещая subVI 

на блок-диаграмме, для того, чтобы они появились на палитре функций по 

приему NI USRP. 

Чтобы протестировать ваш сбор данных VI, начертите диаграмму 

действительных и комплексных частей сигнала и спектр сигнала, 

получаемого niUSRP Fetch Rx Data (poly).vi. Чтобы выполнить эту операцию 

осуществите следующие действия: 
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1. Разместите два графика на лицевой панели вашего VI. Их можно найти 

на палитре инструментов All Controls (Все элементы управления) (All 

Controls=Graph= Waveform Graph.vi) (Все элементы 

управления=График= График колебательного сигнала.vi). 

2. В выпадающем меню niUSRP FetchRxData (poly) выбрать CDB WDT. 

3. С выхода niUSRP FetchRxData (poly) подключаем Comlex To Re/Im VI, 

который можно найти в All Functions⇒Mathematics⇒Numeric⇒ 

Complex⇒Comlex To Re/Im.vi. 

4. Оба выхода Comlex To Re/Im подключаем к Build Array, который 

находится в All Functions⇒Array⇒Build Array. Затем потянем Build 

Array за низ, чтобы получить два входа. 

5. Подключаем график к Build Array, тут мы будем видеть форму сигнала 

(IQ Graph). 

6. Чтобы наблюдать спектр сигнала, подключаем FFT Power Spectrum к 

выходу niUSRP FetchRxData (poly) на тот же провод, что и Comlex To 

Re/Im. Его можно найти в Programming⇒WaveForm⇒Analog 

Waveform⇒Waveform Measurements. Подключаем второй график 

(Baseband Power Spectrum) к FFT Power Spectrum. 

7. На блок-диаграмме, подключите терминал для каждого графика внутри 

цикла (While Loop). 

8. Для корректного отображения шкалы частот на графике спектра 

нажимаем правой кнопкой мыши по графику спектра сигнала 

(Baseband Power Spectrum), в появившемся меню выбираем Create, 

затем Property Node, затем X Scale, затем Offset and Multiplier, затем 

Offset. По появившемуся элементу нажимаем правой кнопкой мыши и 

выбираем Change to Write, затем вход этого элемента подключаем к 

индикатору несущей частоты. 
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9. Настройте устройство на прием УКВ станций радиовещания, по 

спектру определите частоты каждой станции, сделайте скриншот 

полосы, отображающей эти частоты. 

10.  Измените схему таким образом, чтобы можно было посмотреть спектр 

частот для I и Q составляющих сигнала на отдельных графиках. 

Сделайте скриншот блок-диаграммы устройства и его лицевой панели. 
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Рис. 4.2 – Блок-диаграмма устройства приема данных 
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4.2. Программирование устройства генерирования сигнала. 
Необходимо выполнить следующие пункты: 

1. Щелкните мышью на New (Новый), выберите Blank VI (Чистый ВИ), 

и щелкните на OK, чтобы создать чистый VI. 

2. Отобразите блок-диаграмму, нажав кнопкой мыши или выбрав 

Window⇒Show Block Diagram (Окно⇒Показать блок-диаграмму). 

3. Перейдите к VI NI USRP на палитре Functions⇒Instrument 

I/O⇒Instrument Drivers⇒NI-USRP⇒TX (Функции⇒Устройство 

ввода/вывода⇒Драйвера устройства⇒NI-USRP⇒Передача). Когда 

LabVIEW активна, нажмите тут, чтобы просмотреть палитру 

LabVIEW NI USRP TX (Передача NI USRP). 

4. Создайте устройство, показанное на Рисунке 4.3, размещая subVI на 

блок-диаграмме. 

Рис. 4.3 – Блок-диаграмма устройства 

5. Наведите курсор на терминал device name (название устройства) на 

Неэкранированном сеансе передачи VI NI USRP и нажмите на него 

правой кнопкой мыши. Выберите Create⇒Control 

(Создать⇒Элемент управления), чтобы создать поле на лицевой 

панели, где вы определите название устройства. 

6. Наведите курсор на терминалы IQ rate (синфазно-квадратурная 

частота), carrier frequency (несущая частота), и gain (амплитудно-

частотная характеристика) Настройки сигнала VI NI USRP. 
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7. Правой кнопкой мыши нажмите на каждый терминал и выберите 

Create⇒Control (Создать⇒Элемент управления) на контекстном 

меню, чтобы создать частоту, синфазно-квадратурную частоту и 

элементы управления амплитудно-частотной характеристикой. 

8. Отобразите лицевую панель, нажав на нее или выбрав 

Window⇒Show Front Panel (Окно⇒Показать лицевую панель). На 

Рисунке 4.4 отображаются поля, в которых вы можете определить 

частоту, синфазно-квадратурную частоту и амплитудно-частотную 

характеристику. 

 

 

Рис. 4.4. – Лицевая панель устройства 

Генерирование постоянного колебательного сигнала управляется 

посредством кнопки STOP («СТОП»). Кнопка STOP, как правило, 

используется во время Цикла While Loop. Этот пример устанавливает Цикл 

While Loop за Write TX Data VI, чтобы генерирование сигнала продолжалось, 

пока вы не нажмете STOP. 

Создайте Цикл While Loop и кнопку STOP, выполняя следующие шаги: 

1. Отобразите блок-диаграмму, нажав или выбрав Window⇒Show Block 

Diagram (Окно⇒Показать блок-диаграмму). 

2. Выберите Цикл While Loop на палитре All Functions⇒Structures (Все 

функции⇒Структуры). Когда LabVIEW активна, нажмите здесь, чтобы 



 14 

просмотреть Цикл While Loop на палитре Structures (Палитра 

структур). 

3. Включите Запись передачи данных VI NI USRP (Многоразовая) в Цикл 

While Loop. 

4. Наведите курсор на терминал Loop Condition (Состояние выполнения 

цикла) Цикла While Loop. 

5. Правой кнопкой нажмите на терминал Loop Condition (Состояние 

выполнения цикла) и выберите Create Control (Создать элемент 

управления) на контекстном меню, чтобы создать кнопку STOP на 

лицевой панели VI. 

6. Создайте индикатор ошибки, правой кнопкой мыши нажав на терминал 

error out (ошибка на выходе) NI USRP Close Session (Закрыть сессию) 

VI и выбрав Create⇒Indicator (Создать⇒Индикатор). 

Теперь нам надо произвести колебательный сигнал, который будет 

передаваться. Мы будем осуществлять передачу синусоидального сигнала 

при несущей частоте, которая определяется элементом управления carrier 

frequency (несущей частоты). Это обозначает, что сигнал основной полосы 

частот, который мы будем передавать на NI USRP, является просто 

постоянным сигналом. Чтобы сгенерировать данный сигнал, выполните 

следующие шаги: 

1. Поместите функцию Initialize Array (Инициализировать массив) на 

блок-диаграмме. 

2. Правой кнопкой мыши нажмите на вход element (элемент) функции 

Initialize Array и выберите Create⇒Constant (Создать⇒Постоянный 

сигнал). Двойным щелчком мыши нажмите на постоянный сигнал, 

который был создан, и измените его на 1. 
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3. Правой кнопкой мышки нажмите на вход dimension size (размер 

габаритного поля) и выберите Create⇒Control (Создать⇒Элемент 

управления). 

4. Проведите выход функционального блока Initialize Array 

(Инициализировать массив) к информационному входу Записи 

передачи данных VI NI USRP (многоразовой) (Write Tx Data (poly) VI). 

5. В завершение, проведите кнопку STOP, которая была создана для 

Цикла While Loop, до входа end of data? (окончание передачи 

данных?) Записи передачи данных VI NI USRP (многоразовой) (Write 

Tx Data (poly) VI) и выберите БДК (Блок дескриптора команды) в этом 

выпадающем VI меню. 

Вы будете использовать устройство приема сигнала VI, созданное в 

предыдущем разделе, чтобы протестировать свой генератор. Приемник 

позволит вам управлять характеристикой частотной области ваших основных 

синусоидальных колебаний, передаваемых через радиолинию. Для того 

чтобы выполнить эту операцию, сначала необходимо настроить параметры 

для niUSRP Configure Signal.vi (Настроить сигнал NI USRP), указанные ниже. 

Заметьте, что несущий сигнал, генерируемый вашим устройством, будет 

смещен от средней частоты приемника, по сути, создавая 100 кГц 

однополосный (ОБП) модулированный колебательный сигнал на основной 

полосе частот. 

Несущая частота = {2,0001 ГГц на передатчике} и {2,0 ГГц на приемнике} 

Синфазно-квадратурная частота = 400 тыс. 

Амплитудно-частотная характеристика=20 дБ 

Количество отсчетов = 10000 

Активная антенна = RX1 

Вы должны быть готовы постоянно принимать сигнал. После настройки 

параметров, описанных выше, запустите оба VI и управляйте формой 
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колебаний принимаемого сигнала. Сделайте необходимые скриншоты 

работы устройств. 

 

4.3. Программирование устройства генерирования АМ 

сигнала. 
Здесь мы используем уже готовое устройство из пункта 4.2 

лабораторной работы, но изменим часть схемы – Рисунок 4.5. Лицевая 

панель устройства – Рисунок 4.6. 

 

Рис. 4.5. – Устройство генерирования АМ сигнала. 
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Рис. 4.6. – Лицевая панель устройства генерирования АМ сигнала.  

1. Замените функцию Initialize Array на функцию Basic Function 

Generator (основной генератор функций). Эта функция позволит 

выбирать тип модулирующего сигнала. 

2. Создайте все необходимые элементы управления как на рисунке 4.5. 

3. Запустите устройство генерирования АМ сигнала.  

4. Запустите устройство приема сигнала, собранное в пункте 4.1, 

настройте его на прием сигнала от генератора, собранного в данной 

части лабораторной работы (Рисунок 4.5). 

5. Получите сигнал как на рисунке 4.7, управляя настройками приемника. 

Объясните почему такой спектр у АМ сигнала. Измените ширину 

спектра. Сделайте необходимые скриншоты для отчета. 



 18 

 

Рис. 4.7. – АМ сигнал и его спектр 

 

5. Содержание отчета 

1. Титульный лист 

2. Цель работы 

3. Ход работы (предоставьте все необходимые скриншоты по каждой 

части лабораторной работы, поясните что они демонстрируют, 

предоставьте список, найденных вами станций радиовещания, 

напишите ответы на вопросы по Части 4.1 п. 9-10, Части 4.3 п. 5)  

4. Анализ результатов и выводы 

 

6. Контрольные вопросы 

1. В 2-3 предложениях опишите работу NI USRP при передаче данных 

(например, какие существуют входы/выходы для USRP?). 

2. В 2-3 предложениях опишите основную работу NI USRP при приеме 

данных (например, какие существуют входы/выходы для USRP?). 

3. Каков диапазон допустимой несущей/средней частоты, 

поддерживаемой NI-USRP? 
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4. Какова максимально допустимая ширина полосы частот, 

поддерживаемая NI-USRP? 

5. Какова максимальная частота дискретизации NI-USRP? 

6. Какие три компонента в выходе кластера данных существуют в niUSRP 

Fetch Rx Data (poly).vi? Укажите название и тип данных по каждому 

компоненту. 


